Lexium CT
Commissioning software
Product manual
V2.00, 09.2008
Important information

This manual is part of the product.
Carefully read this manual and observe all instructions.
Keep this manual for future reference.
Hand this manual and all other pertinent product documentation over to all users of the product.
Carefully read and observe all safety instructions and the chapter "Before you begin - safety information".

Some products are not available in all countries.
For information on the availability of products, please consult the catalog.
Subject to technical modifications without notice.
All details provided are technical data which do not constitute warranted qualities.
Most of the product designations are registered trademarks of their respective owners, even if this is not explicitly indicated.
# Table of Contents

**Important information** ........................................... 2  
Table of Contents .................................................. 3  
Writing conventions and symbols. ................................. 7  

1 **Introduction** .................................................... 9  
1.1 General features ............................................... 9  

2 **Before you begin - safety information** ....................... 11  
2.1 Qualification of personnel ................................. 11  
2.2 Intended use ................................................ 11  
2.3 Hazard categories ........................................... 12  
2.4 Basic information ............................................ 13  
2.5 Standards and terminology ............................... 14  

3 **Installation** .................................................. 15  
3.1 PC requirements ............................................. 15  
3.2 Installation procedure ..................................... 15  

4 **Lexium CT ProductExplorer** ............................... 19  
4.1 The user interface ......................................... 19  
4.1.1 The menu bar ........................................ 20  
4.1.2 Tree View .......................................... 20  
4.1.3 Detail View ......................................... 21  
4.2 First steps ................................................ 22  
4.2.1 Important terms .................................... 22  
4.2.2 Connection prerequisites .......................... 23  
4.2.3 Scanning the network ............................. 23  
4.2.4 Direct connection to supported products .... 25
5 Lexium CT M1 .......................................................... 27
  5.1 The user interface ............................................. 27
  5.1.1 The menu bar ........................................... 28
  5.1.2 The toolbar ............................................ 28
  5.1.3 Control bar and status bar .............................. 29
  5.2 First steps .................................................. 29
  5.2.1 Important terms ......................................... 29
  5.2.2 The first connection ................................. 31
  5.3 Parameter file ............................................. 32
  5.3.1 Saving a file .......................................... 32
  5.3.2 Opening a file ........................................ 32
  5.3.3 Exporting parameters ............................... 33
  5.3.4 Printing parameters ................................. 33
  5.4 Parameterization .......................................... 34
  5.4.1 Opening the parameter window ..................... 34
  5.4.2 Transferring parameter values ..................... 35
  5.4.3 Restoring the factory settings .................... 36
  5.5 Functions .................................................. 37
  5.5.1 Changing the operating state ..................... 37
  5.5.2 Operating modes .................................... 37
  5.5.3 Recording and optimizing ......................... 44
  5.5.4 Inputs and outputs ................................ 48
  5.6 Diagnostics ................................................ 49
  5.6.1 Device information ................................ 49
  5.6.2 Error memory ....................................... 50
  5.6.3 Monitoring parameters ............................ 51
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Lexium CT M2</td>
</tr>
<tr>
<td>6.1</td>
<td>The user interface</td>
</tr>
<tr>
<td>6.1.1</td>
<td>The menu bar</td>
</tr>
<tr>
<td>6.1.2</td>
<td>The toolbar</td>
</tr>
<tr>
<td>6.1.3</td>
<td>Control bar and status bar</td>
</tr>
<tr>
<td>6.2</td>
<td>First steps</td>
</tr>
<tr>
<td>6.2.1</td>
<td>Important terms</td>
</tr>
<tr>
<td>6.2.2</td>
<td>The first connection</td>
</tr>
<tr>
<td>6.3</td>
<td>Parameter file</td>
</tr>
<tr>
<td>6.3.1</td>
<td>Saving a file</td>
</tr>
<tr>
<td>6.3.2</td>
<td>Opening a file</td>
</tr>
<tr>
<td>6.3.3</td>
<td>Exporting parameters</td>
</tr>
<tr>
<td>6.3.4</td>
<td>Printing parameters</td>
</tr>
<tr>
<td>6.4</td>
<td>Parameterization</td>
</tr>
<tr>
<td>6.4.1</td>
<td>Opening the parameter window</td>
</tr>
<tr>
<td>6.4.2</td>
<td>Transferring parameter values</td>
</tr>
<tr>
<td>6.4.3</td>
<td>Restoring the factory settings</td>
</tr>
<tr>
<td>6.4.4</td>
<td>Resetting user parameters</td>
</tr>
<tr>
<td>6.4.5</td>
<td>Calculating control loop parameters</td>
</tr>
<tr>
<td>6.5</td>
<td>Functions</td>
</tr>
<tr>
<td>6.5.1</td>
<td>Changing the operating state</td>
</tr>
<tr>
<td>6.5.2</td>
<td>Operating modes</td>
</tr>
<tr>
<td>6.5.3</td>
<td>Recording and optimizing</td>
</tr>
<tr>
<td>6.5.4</td>
<td>Inputs and outputs</td>
</tr>
<tr>
<td>6.6</td>
<td>Diagnostics</td>
</tr>
<tr>
<td>6.6.1</td>
<td>Device information</td>
</tr>
<tr>
<td>6.6.2</td>
<td>Error memory</td>
</tr>
<tr>
<td>6.6.3</td>
<td>Monitoring parameters</td>
</tr>
<tr>
<td>7</td>
<td>Diagnostics and troubleshooting</td>
</tr>
<tr>
<td>7.1</td>
<td>Error indication</td>
</tr>
<tr>
<td>8</td>
<td>Glossary</td>
</tr>
<tr>
<td>8.1</td>
<td>Units and conversion tables</td>
</tr>
<tr>
<td>8.1.1</td>
<td>Length</td>
</tr>
<tr>
<td>8.1.2</td>
<td>Mass</td>
</tr>
<tr>
<td>8.1.3</td>
<td>Force</td>
</tr>
<tr>
<td>8.1.4</td>
<td>Power</td>
</tr>
<tr>
<td>8.1.5</td>
<td>Rotation</td>
</tr>
<tr>
<td>8.1.6</td>
<td>Torque</td>
</tr>
<tr>
<td>8.1.7</td>
<td>Moment of inertia</td>
</tr>
<tr>
<td>8.1.8</td>
<td>Temperature</td>
</tr>
<tr>
<td>8.1.9</td>
<td>Conductor cross section</td>
</tr>
<tr>
<td>8.2</td>
<td>Terms and Abbreviations</td>
</tr>
<tr>
<td>9</td>
<td>Index</td>
</tr>
</tbody>
</table>
Writing conventions and symbols

Work steps
If work steps must be performed consecutively, this sequence of steps is represented as follows:

- Special prerequisites for the following work steps
  - Step 1
- Specific response to this work step
  - Step 2

If a response to a work step is indicated, this allows you to verify that the work step has been performed correctly.

Unless otherwise stated, the individual steps must be performed in the specified sequence.

Bulleted lists
The items in bulleted lists are sorted alphanumerically or by priority. Bulleted lists are structured as follows:

- Item 1 of bulleted list
- Item 2 of bulleted list
  - Subitem for 2
  - Subitem for 2
- Item 3 of bulleted list

Making work easier
Information on making work easier is highlighted by this symbol:

Sections highlighted this way provide supplementary information on making work easier.

Menu paths "⇒" Action steps within the menu are described with complete menu path and the "⇒" symbol, e.g. "⇒ File ⇒ Save As...".

SI units SI units are the original values. Converted units are shown in brackets behind the original value; they may be rounded.

Example:
Minimum conductor cross section: 1.5 mm² (AWG 14)
1 Introduction

1.1 General features

The Lexium CT commissioning software is an application program for PCs that allows you to commission and diagnose many of our products. The functions of the commissioning software automatically adapt to the products. Therefore, some functions may not be available. For details see the product manual.

The Lexium CT commissioning software consists of 3 different user interfaces:
- Lexium CT ProductExplorer
- Lexium CT M1
- Lexium CT M2

The "Lexium CT ProductExplorer" is used to scan fieldbus networks for products or to read information directly from supported products. The "Lexium CT ProductExplorer" provides additional information on the supported products such as the product manual or information from the Internet. If a device is found on the fieldbus network, it is possible to establish a connection with the product without additional connection settings. The "Lexium CT ProductExplorer" automatically selects the appropriate user interface, "Lexium CT M1" or "Lexium CT M2", for the product. "Lexium CT M1" or "Lexium CT M2" are used to commission the product.

**Functions of the commissioning software**

The functions of the commissioning software include:
- Scan various fieldbuses for devices
- Extensive information on connected devices
- Display and enter device parameters
- Archive and duplicate device parameters
- Manual positioning of the motor
- Test input and output signals
- Record, evaluate and archive motion and signals
- Error diagnostics
- Optimize control behavior (servo motors only)

**Supported devices**

The product manual of the specific device describes whether the commissioning software can be operated with the device.

*You must be familiar with the Windows operating system to work with the commissioning software.*
2 Before you begin - safety information

2.1 Qualification of personnel

Only appropriately trained persons who are familiar with and understand the contents of this manual and all other pertinent product documentation are authorized to work on and with this product. In addition, these persons must have received safety training to recognize and avoid hazards involved. These persons must have sufficient technical training, knowledge and experience and be able to foresee and detect potential hazards that may be caused by using the product, by changing the settings and by the mechanical, electrical and electronic equipment of the entire system in which the product is used.

All persons working on and with the product must be fully familiar with all applicable standards, directives, and accident prevention regulations when performing such work.

2.2 Intended use

This product is a commissioning software and intended for industrial use according to this manual.

The commissioning software is intended for commissioning and diagnostics of the supported products. The supported products are displayed by the user interface. Do not use the software to operate products.

The product may only be used in compliance with all applicable safety regulations and directives, the specified requirements and the technical data.

The information concerning the intended use of the products also applies.

Any use other than the use explicitly permitted is prohibited and can result in hazards.
2.3 Hazard categories

Safety instructions to the user are highlighted by safety alert symbols in the manual. In addition, labels with symbols and/or instructions are attached to the product that alert you to potential hazards.

Depending on the seriousness of the hazard, the safety instructions are divided into 4 hazard categories.

---

**DANGER**

DANGER indicates an imminently hazardous situation, which, if not avoided, will result in death or serious injury.

---

**WARNING**

WARNING indicates a potentially hazardous situation, which, if not avoided, can result in death, serious injury, or equipment damage.

---

**CAUTION**

CAUTION indicates a potentially hazardous situation, which, if not avoided, can result in injury or equipment damage.

---

**CAUTION**

CAUTION used without the safety alert symbol, is used to address practices not related to personal injury (e.g. can result in equipment damage).
2.4 Basic information

⚠️ WARNING

LOSS OF CONTROL
Misoperation of the PC or the software may result in a loss of control of the system (no stop, unexpected responses).

- Verify that a functioning button for EMERGENCY STOP is within reach.
- Verify that the system is free and ready for the motion before connecting the system to the PC.

Failure to follow these instructions can result in death, serious injury or equipment damage.

⚠️ WARNING

UNEXPECTED MOVEMENT
When the drive is operated for the first time, there is a risk of unexpected movements caused by possible wiring errors or unsuitable parameters.

- Perform the first test run without coupled loads.
- Verify that a functioning button for EMERGENCY STOP is within reach.
- Anticipate movements in the incorrect direction or oscillation of the drive.
- Only start the system if there are no persons or obstructions in the hazardous area.

Failure to follow these instructions can result in death, serious injury or equipment damage.
2.5 Standards and terminology

Technical terms, terminology and the corresponding descriptions in this manual are intended to use the terms or definitions of the pertinent standards.

In the area of drive systems, this includes, but is not limited to, terms such as "safety function", "safe state", "fault", "fault reset", "failure", "error", "error message", "warning", "warning message", "alarm", etc.

Among others, these standards include:

- IEC 61800 series: "Adjustable speed electrical power drive systems"
- IEC 61800-7 series: "Adjustable speed electrical power drive systems - Part 7-1: Generic interface and use of profiles for power drive systems - Interface definition"
- IEC 61158 series: "Industrial communication networks - Fieldbus specifications"
- IEC 61784 series: "Industrial communication networks - Profiles"
- IEC 61508 series: "Functional safety of electrical/electronic/programmable electronic safety-related systems"

Also see the glossary at the end of this manual.
3 Installation

Source commissioning software

The latest version of the commissioning software is available for download from the internet:

http://www.schneider-electric.com

3.1 PC requirements

System requirements

The minimum hardware requirements for installation and operation of the software are:

- IBM-compatible PC
- Approx. 200 MB of hard disk space
- 512 MB RAM
- Graphics card and monitor with a resolution of at least 1024x768 pixels
- Free serial interface (RS232) or free USB interface
- Operating system Windows 2000, Windows XP Professional or Windows Vista
- Acrobat Reader 5.0 or newer
- Internet connection (for initial installation and updates)

Required accessories

- RS232 to RS485 converter or USB to RS485 converter

<table>
<thead>
<tr>
<th>Interface</th>
<th>PC interface</th>
<th>Required fieldbus converter</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>RS485</td>
<td>RS232</td>
<td>NuDAM ND-6520</td>
<td><a href="http://www.acceed.com">http://www.acceed.com</a></td>
</tr>
<tr>
<td>RS485</td>
<td>USB</td>
<td>NuDAM ND-6530</td>
<td><a href="http://www.acceed.com">http://www.acceed.com</a></td>
</tr>
<tr>
<td>CAN</td>
<td>parallel</td>
<td>PCAN dongle, Peak</td>
<td><a href="http://www.peak-system.com">http://www.peak-system.com</a></td>
</tr>
<tr>
<td>CAN</td>
<td>USB</td>
<td>PCAN-USB, Peak</td>
<td><a href="http://www.peak-system.com">http://www.peak-system.com</a></td>
</tr>
<tr>
<td>PROFIBUS DP</td>
<td>PCMCIA</td>
<td>Siemens CP5611/13</td>
<td><a href="http://www.ad.siemens.de">www.ad.siemens.de</a></td>
</tr>
<tr>
<td>PROFIBUS DP</td>
<td>PCI</td>
<td>Siemens CP5611/12</td>
<td><a href="http://www.ad.siemens.de">www.ad.siemens.de</a></td>
</tr>
<tr>
<td>PROFIBUS DP</td>
<td>USB</td>
<td>PROFIusb PB-USB</td>
<td><a href="http://www.softing.com">http://www.softing.com</a></td>
</tr>
<tr>
<td>DeviceNet</td>
<td>USB</td>
<td>USB to CAN compact</td>
<td><a href="http://www.ixxat.com">www.ixxat.com</a></td>
</tr>
</tbody>
</table>

3.2 Installation procedure

We recommend backing up important data regularly and always before installing new software.

- Verify the PC meets the requirements.
- Verify that you can connect to the internet.
- Start the installation via the file "LexiumCTInstall.exe".

The following dialog box is displayed:
3 Installation

Select the installation language from the drop-down menu.

The following dialog box is displayed:

Internet connection via proxy server

- Check whether your site uses a proxy server (if necessary, get in touch with your network administrator). If you are in a network that uses a proxy server to connect to the internet, proceed as follows:

  - Check the "Edit Proxy settings" and click the "Next" button.
  - The following dialog box is displayed:
Click “Read settings from Internet-Explorer” or enter the information for your proxy server in the appropriate fields. Please check back with your network administrator for the required connection information.

Click “Next”.

**Internet connection without proxy server**

If you do not use a proxy server, proceed as follows:

Click “Next” without checking the “Edit Proxy settings” checkbox or select “Direct connection” in the “Proxy settings” dialog box.

**Selecting the used products**

If necessary, the correct proxy server settings have been entered and a connection to the internet has been established.

The following dialog box is displayed:
Check each product that you want to commission with the commissioning software.

It is possible to add individual products to the list at a later point in time. To do so, choose "Internet Update" from the Windows Start menu ("⇒ Start ⇒ Programs ⇒ Schneider Electric ⇒ Lexium CT").

The program is installed in the folder "%ProgramFiles%\Schneider Electric\Lexium CT".

A shortcut is created in the Windows start menu for starting the commissioning software.

Check the "Create media for an offline installation" to create an up-to-date installation routine on your hard disk. This routine can be copied to another computer that does not have an internet connection (use a flash drive, for example).

If you have checked the "Create media for an offline installation", the software will prompt you for a target folder. The offline installation requires up to 200 MB of free disk space.
4 Lexium CT ProductExplorer

The commissioning software can be started via the shortcut in the Windows Start menu ("⇒ Start ⇒ Programs ⇒ Schneider Electric ⇒ Lexium CT").

4.1 The user interface

The screenshot shows the user interface of the ProductExplorer.

Figure 4.1 Elements of the ProductExplorer

(1) Menu bar
(2) Tree View
(3) Detail View
(4) Status bar

The functions of the commissioning software can be executed via the menu bar and, to a large degree, by means of right-clicking or double-clicking.
4.1.1 The menu bar

The menu bar provides access to the functions of the software. It structures the functions just like in other application programs.

If you move the mouse pointer over a button, the software displays a "Tooltip"; in addition, a short description of the function may be shown in the "status bar".

4.1.2 Tree View

The Tree View allows you to access the individual devices. The view is divided into two areas:

- Scanning the network
  The devices are grouped by fieldbus. You can scan a fieldbus network with different device types and unknown addresses. The devices found will be displayed in an overview list.

- Supported drives
  The devices are grouped by model. The available fieldbuses are shown below the product. In addition, you can access the corresponding manuals and product information.
4.1.3 Detail View

The Detail View provides the following functions:

- Display of detailed information on devices found on the network
- Display of product manuals
- Access to online information on the products
4.2 First steps

4.2.1 Important terms

Data interface  Depending on the product, data communication is performed via "Modbus RTU", "DeviceNet", "RS485 für ILx1", "CANopen DS301" or "Mobus TCP". RS485 is the standard commission interface; it is available for all products. Depending on the product, the RS485 protocol used is either a vendor-specific protocol (ILx1) or the "Modbus RTU" protocol.

Update  Updates are used to get the latest version of the software. You need an internet connection to update the software. If you encounter problems during an update, have your internet access checked by your network administrator. It is recommended to update the software at regular intervals.

The software can automatically check for available updates. If the software is running, a background process checks whether new updates are available. To use this function:

► Use the following menu item "⇒ Extras ⇒ Settings"

='< The following dialog box is displayed:

► Check the "Automatically check for updates for: -Lexium CT" checkbox.

► Depending on your preferences, the updates can be installed immediately or after the next start of the software.

To start an update manually:

► Save all data and quit the "Lexium CT M1" and "Lexium CT M2" user interfaces.

► Use the following menu item: "⇒ Help ⇒ Check for updates"

='< The software prompts you for confirmation.

► Click "Yes".

='< The "Lexium CT ProductExplorer" user interface is closed and the update process is started. The system displays the "Lexium CT Updater".

► Follow the instructions on page 16.
4.2.2 Connection prerequisites

Check the following before you establish the first connection:

- Have you switched on the product?
- Do you need a driver for the fieldbus converter used; have you installed this driver?
- Did you properly connect all cables and fieldbus converters?
- Has the product been installed during the installation process?

4.2.3 Scanning the network

The Tree View to the left provides the function "Search the network". The function "Search the network" scans a defined network range for products.

To scan the network:

- Double-click "Configuration" below the appropriate fieldbus protocol node.
- The following dialog box is displayed:

```
Figure 4.4 Network scan
```

- Set the values as required for your product and click "OK".
- Right-click "Network" below the appropriate fieldbus protocol node and select "Configure the network scan".
The following dialog box is displayed:

![Network scan range dialog box](image)

**Figure 4.5** Network scan range

- Set the address range you want to scan and click "OK".

If you have already set the network range, the range is automatically scanned when you click "Network". To select a different range, right-click "Network" and select "Configure the network scan".

- If one or more products are found, the software displays the window "Product found" with the data of the found products. If newer products are found, the "Detail View" displays detailed product information.

**Figure 4.6** Devices found
Connecting to devices found

- The network scan found one or more products.
  - Select the desired product from the list and click the "Connect" button.
  - Depending on the product, the system displays "Lexium CT M1" or "Lexium CT M2". The connection settings are automatically made available in the windows of "Lexium CT M1" or "Lexium CT M2". In the new window, click "Connect".

4.2.4 Direct connection to supported products

If the connection data and the device type are known, you can directly establish a connection to the product.

- Double-click the fieldbus protocol to be used below the product name node.
- The following dialog box is displayed:

![Connection dialog box]

- Adjust the connection settings for your product and click "OK".
If a product is found, the software displays a window with device information. At the same time, the "Detail View" provides detailed product information:

- Double-click a list entry in the "Product found" window to start the commissioning software for the corresponding product.
5 Lexium CT M1

Depending on the product, the "Lexium CT ProductExplorer" starts the "Lexium CT M1" software.

5.1 The user interface

The following screenshot shows the user interface of the commissioning software.

![User Interface of Lexium CT M1](image)

Figure 5.1 User interface Lexium CT M1

(1) Menu bar
(2) Toolbar
(3) Control bar and status bar

The functions of the commissioning software can be accessed via the menu bar, the toolbar, the control bar and the status bar.
5.1.1 The menu bar

The menu bar adapts to the task at hand. It only contains the functions required for and possible in the current situation.

For example, if there is no connection to the device, the function "⇒ Connection ⇒ Disconnect" is not available.

5.1.2 The toolbar

The toolbar provides fast, single-click access to frequently used functions.

The buttons let you execute the following functions:

Figure 5.2 Toolbar

(1) ⇒ File ⇒ Open...
(2) ⇒ File ⇒ Save
(3) ⇒ Connection ⇒ RS485 connection...
(4) ⇒ Connection ⇒ Disconnect
(5) ⇒ Connection ⇒ Options
(6) ⇒ Parameter ⇒ Open parameter window...
(7) ⇒ Functions ⇒ Operating modes...
(8) ⇒ Functions ⇒ Record/Tuning...
(9) ⇒ Functions ⇒ Inputs+Outputs...
(10) ⇒ Diagnostics ⇒ Device info...
(11) ⇒ Diagnostics ⇒ Error memory...
(12) ⇒ Diagnostics ⇒ Object monitoring...

If you move the mouse pointer over a button, the software displays a "Tooltip"; in addition, a short description of the function may be shown in the "status bar".
5.1.3 Control bar and status bar

The control bar and the status bar allow you to access the device. The control bar and the status bar can be used to enable the power stage and display various status information.

Figure 5.3 Control bar and status bar

(1) Enable
(2) Status information
(3) Operating state
(4) Stop
(5) Reset
(6) Current error

Enable The switch "Enable" allows you to enable and disable the power stage of the device. For more information on enabling or disabling the power stage see the product manual of the device.

Status information This information consists of:
- Line 1 shows whether the function "Halt" is active
- Line 2 displays the current motor position
- Line 3 shows the status of the access control
- Line 4 shows the control mode

Operating state The commissioning software shows the current operating state of the connected device. For more information on the operating state see the product manual of the device.

Stop The "Stop" button allows you to stop the motor with a "Quick Stop". For more information on "Quick Stop" see the product manual of the device.

Reset The "Reset" button is used to acknowledge an error message. For more information on acknowledging error messages see the product manual of the device.

Current error The field shows the currently active asynchronous error.

5.2 First steps

5.2.1 Important terms

Device data The term device data refers to all parameter values of a device. They are saved to the EEPROM of the device to avoid loss in case of a power outage.

Transferring device data Device data can be transferred between the device and the PC only if there is a connection. It is possible to transfer all parameters or groups of parameters.
NOTE: In a first step, the commissioning software transfers modified parameters to the RAM memory of the device. They remain there until the controller supply voltage is switched off. Note that the device data must be saved separately to the EEPROM memory so they are permanently available to the product.

**Parameter file**

The device data can be saved to the PC and loaded.

On the PC, all device data is saved in one file, the parameter file. The commissioning software saves the complete parameter set in the file.

The PC and the device do not have to be connected if you want to edit the parameter file.
5.2.2 The first connection

The device must be connected to the PC via the data interface. Use the menu item "⇒ Connection ⇒ RS485 connection..." to connect to the device. This opens the "Connection" dialog box.

The screenshot below shows an example.

![Connection RS485 dialog box]

If you want to use a different fieldbus interface, selected it with the menu item "⇒ Connection ⇒ Options...":

![Options dialog box]

*Connection* The device data is transferred to the PC when a connection is established. After transfer the commissioning software is connected to the device in online mode.
5.3 Parameter file

Parameter files have the extension ".ifx". Even if there is no connection to the device, you can open and edit any device file on the PC. In addition to the parameter values, the file contains the contents of the error memory, all actual values and recorded data.

5.3.1 Saving a file

On the PC, device data on the PC can be saved to a parameter file, for example, to archive it for maintenance and service purposes. This also allows you to quickly commission additional devices of the same device version.

To save a parameter file on the PC, use the menu items "⇒ File ⇒ Save..." or "⇒ File ⇒ Save as...."

*It is recommended to save all device data in the form of a parameter file after you have commissioned a device. This way the device can be put back into operation immediately after a repair.*

5.3.2 Opening a file

Use the menu item "⇒ File ⇒ Open..." to open a parameter file on the PC.

If there is a connection to the device, the commissioning software checks whether the parameter file is compatible with the device.

If the parameter file is compatible with the device, the stored parameter values of the parameter file are compared to the parameter values of the device. Differences are highlighted by a colored background.

If the parameter file is not compatible with the device, the loading process is canceled and an error message is displayed.
5.3.3 Exporting parameters

All device parameters that can be written can be saved as a .csv file for further processing. This function can be accessed via the menu item "⇒ File ⇒ Export parameters.".

The file is saved with the extension " .csv". You can open and edit this file Microsoft Excel.

5.3.4 Printing parameters

The menu item "⇒ File ⇒ Print parameters..." allows you to print the device data. The printed data is arranged in groups:

- Config
- RS485
- Settings
- Motion
- I/O
- Homing
- Manual
- DataSet
- ProgIO0
- ProgIO1
- ProgIO2
- ProgIO3

In addition, the device type, serial number and information on the software are printed.
5.4 Parameterization

The data of a device can be edited in the "Parameter" window. A connection to the device is not required. The parameter values of a file can be modified in off-line mode and transferred to the device at a later point in time.

5.4.1 Opening the parameter window

Use the menu item "⇒ Parameter ⇒ Open parameter window..." to open the Parameter window.

![Parameter window](image)

Figure 5.5 Parameter window

The screenshot shows the parameter window. The contents of this window depends on the device version. However, the general structure is always the same. The left pane shows items, the associated parameters are displayed in the right pane.

**Parameters of a group**
The parameter window shows the parameters associated with the selected item. The list shows the names, values, unit, a description, the range and the Modbus address.

**Changing parameter values**
The value of a parameter is changed in the "Value" column. Values with a gray background are read-only and cannot be modified.

Modified values that have not been transferred to the device are highlighted by a colored background. At the same time the parameter group to which the parameter belongs is highlighted by a red exclamation mark. As soon as the values have been transmitted to the device, the exclamation mark is cleared.

To change a parameter value, you can enter the new value directly or choose it from a list.

**Checking the value range**
The commissioning software checks whether the parameter values entered are in the permissible value range. If the value entered is not in the valid range, the value is not accepted.
5.4.2 Transferring parameter values

When the controller supply voltage to the device is switched on, the device data is automatically copied from the EEPROM to the RAM. The devices only operate with the data contained in the RAM.

The data exchange between the device and the PC is controlled by the following menu items and buttons.

**Menu items**

The menu items "⇒ Parameter ⇒ Send parameter group to drive" and "⇒ Parameter ⇒ Send all parameters to drive" allow you to transmit parameter values from the PC to the device.

The menu items "⇒ Parameter ⇒ Load parameter group from drive" and "⇒ Parameter ⇒ Load all parameters from drive" are used to transmit parameter values from the device to the PC.

**Buttons**

The buttons let you execute the following functions:

(1) ⇒ Parameter ⇒ Send parameter group to drive
(2) ⇒ Parameter ⇒ Load parameter group from drive
(3) ⇒ Parameter ⇒ Send all parameters to drive
(4) ⇒ Parameter ⇒ Load all parameters from drive
(5) ⇒ Parameter ⇒ Save device parameters in EEPROM

Not all parameters can be transferred in operating state "Operation Enable". Parameter values that cannot be transferred are highlighted by a colored background.
5.4.3 Restoring the factory settings

Use the menu item "⇒ Parameter ⇒ Reset to factory settings" to restore the factory settings of all parameters.

Figure 5.7 Restoring the factory settings

After confirmation with "OK" all device parameters are reset to the factory setting.
5.5 Functions

The "Functions" menu provides access to the following functions:

- Operating modes
- Recording and tuning
- Inputs and outputs

The screenshots below may be different or unavailable in your system due to different functionalities of the devices.

5.5.1 Changing the operating state

⚠️ WARNING

UNEXPECTED MOVEMENT

When the drive is operated for the first time, there is a risk of unexpected movements caused by possible wiring errors or unsuitable parameters.

- Perform the first test run without coupled loads.
- Verify that a functioning button for EMERGENCY STOP is within reach.
- Anticipate movements in the incorrect direction or oscillation of the drive.
- Only start the system if there are no persons or obstructions in the hazardous area.

Failure to follow these instructions can result in death, serious injury or equipment damage.

The device can now be set to operating state 6 "Operation Enable" with the commissioning software. In this operating state the power stage of the device is enabled. To do so, click the "Enable" switch. For more information on enabling or disabling the power stage see the product manual of the device.

The device must be in operating state 6 "Operation Enable" for the functions of the commissioning software to be executed.

5.5.2 Operating modes

Use the menu item "⇒ Functions ⇒ Operating modes..." to start the "Operating modes" function.

The various operating modes can be selected from the tabs in the Operating Modes window.

The window is subdivided into two sections:

- Tab for the selected operating mode and for setting specific parameters (top section)
- Display of some status information (bottom section)

The user can switch between the tabs in the Operating Modes window without interfering with a currently active operating mode.
Device monitoring

During movements, the connection to the device is cyclically monitored. If the connection between the PC and device is lost, the motor stops within the cycle time.

The commissioning software cannot be exited while a movement is running.

All operating modes are described in detail in the product manuals. Therefore, this manual does not describe the details of the operating modes.

Profile position

In Profile Position operating mode, a movement with an adjustable motion profile is performed from a start position to a target position. The value of the target position can be specified as either a relative or an absolute position.

You can set a motion profile with values for acceleration ramp, deceleration ramp and target speed.

![Figure 5.8 Operating mode Profile Position](image)

Profile Velocity

In the operating mode Profile Velocity, the drive accelerates to an adjustable target speed of rotation. You can set a motion profile with values for acceleration and deceleration ramps.

![Figure 5.9 Operating mode Profile velocity](image)
**Homing**
The operating mode Homing establishes an absolute position reference between the motor position and a defined axis position. Homing can be carried out by a means of a reference movement or by position setting.

![Operating mode Homing](image)

**Jog**
The motor is moved at slow or fast jog speed with the buttons. The motor moves as long as the button is held down. When you release the button, the motor is decelerated to a standstill.

![Operating mode Jog](image)

**Electronic gear**
In the operating mode Electronic Gear, reference signals are supplied in the form of A/B signals or pulse/direction signals. A new position reference value is calculated on the basis of these signals plus an adjustable gear ratio.

![Operating mode Electronic Gear](image)
In the Oscillator operating mode, the motor is moved corresponding to a voltage-dependent reference speed. There are two options:

- Selection of speed of rotation directly in the window by entering the value or using the slider.
- Supply of the value via the analog input ANA1. The voltage value can also be set in the "Inputs+Outputs" window for this option.

The actual movement is started or stopped with the "Start" and "Stop" buttons.

**WARNING**

**UNEXPECTED MOVEMENT**

In this operating mode, an unknown voltage value at the analog input may cause an unexpectedly high speed of rotation of the motor.

- Observe the voltage value at the analog input when starting the operating mode.

Failure to follow these instructions can result in death, serious injury or equipment damage.

In the Oscillator operating mode, the motor is moved corresponding to a voltage-dependent reference speed. There are two options:

- Selection of speed of rotation directly in the window by entering the value or using the slider.
- Supply of the value via the analog input ANA1. The voltage value can also be set in the "Inputs+Outputs" window for this option.

The actual movement is started or stopped with the "Start" and "Stop" buttons.
In the Speed Control operating mode, the motor is moved corresponding to a voltage-dependent reference speed. There are two options:

- Selection of the value directly in the window by entering the value or using the slider
- Supply of the value via the analog input ANA1. The voltage value can also be set in the "Inputs+Outputs" window for this option.

The actual movement is started or stopped with the "Start" and "Stop" buttons.

**Figure 5.14 Operating mode Speed Control**
Current control

⚠️ WARNING

UNEXPECTED MOVEMENT
In this operating mode, an unknown voltage value at the analog input may cause an unexpectedly high speed of rotation of the motor.

- Observe the voltage value at the analog input when starting the operating mode.

Failure to follow these instructions can result in death, serious injury or equipment damage.

In the Current Control operating mode, the motor is moved corresponding to a voltage-dependent reference current. There are two options:

- Selection of current directly in the window by entering the value or using the slider
- Supply of the value via the analog input ANA1. The voltage value can also be set in the "Inputs+Outputs" window for this option.

The actual movement is started or stopped with the "Start" and "Stop" buttons.

Figure 5.15 Operating mode Current Control
Autotuning

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNEXPECTED MOVEMENT</td>
</tr>
<tr>
<td>Autotuning moves the motor in order to tune the controller. Incorrect parameters may cause unexpected movements or the loss of monitoring functions.</td>
</tr>
<tr>
<td>• Check the parameters AT_dir and AT_dis. The distance required for the deceleration ramp must also be taken into account.</td>
</tr>
<tr>
<td>• Verify that the parameter LIM_I_maxQSTP for QuickStop is correctly set.</td>
</tr>
<tr>
<td>• If possible, use the limit switches LIMN and LIMP.</td>
</tr>
<tr>
<td>• Verify that a functioning button for EMERGENCY STOP is within reach.</td>
</tr>
<tr>
<td>• Make sure that the system is free and ready for the motion before starting the function.</td>
</tr>
</tbody>
</table>

**Failure to follow these instructions can result in death, serious injury or equipment damage.**

Autotuning determines the friction torque, a constantly effective load torque, and considers this in the calculation of the mass moment of inertia of the entire system.
5.5.3 Recording and optimizing

*Introduction*  The commissioning software provides the “Recording/Tuning” function for visualizing internal device data during movements. The connected device stores the movement data to an internal memory for a defined recording period and then sends it to the PC. The PC processes the data and displays them in the form of charts or tables.

Recorded data can be saved on the PC, see chapter 5.3.1 "Saving a file", and can be archived or printed for documentation purposes.

Use the menu item "⇒ Functions ⇒ Record/Tuning..." to start the "Record" function.

![Chart](image)

**Figure 5.17 Recording**

Elements of the recording window:

1. Buttons
2. Chart with the recorded data
3. Tabs for recording, trigger and tuning

**Chart**  A chart is only shown if at least one parameter was selected.

Each of the selected parameters is shown in a distinct color.
Buttons

Figure 5.18 Buttons

1. Starting recording
2. Stop recording
3. Manual zoom, infinitely variable zoom of x axis and y axis
4. Zoom Box
5. Zoom in, y axis
6. Zoom out, y axis
7. 1nd display of values for a specific time
8. Reset zoom, auto zoom
9. Invert y axis
10. Display table of recorded values
11. Enter comment
12. Print recording
13. Save recording
14. Open recording

Tab "Record"

The "Record" tab allows you to configure the recording function.

Figure 5.19 Tab Recording

The "Parameters" dropdown lists allow you to select the desired parameters.

The "Timebase" dropdown list is used to set the time resolution. The smaller the "Timebase", the shorter the maximum recording time.

The desired number of measurement points is entered in the "Measurements" field. A maximum of 100 measurements can be taken during one recording run.
**Tab "Trigger"**  
The desired triggering for the recording is configured on the "Trigger" tab. Recording starts once the specified condition has been met.

![Figure 5.20 Tab Trigger](image)

The parameter to be monitored is selected from the "Trigger" dropdown list.

The condition the selected parameter must meet for the recording to be started is selected from the "Condition" dropdown list.

Enter a decimal value in the "Value" field; this is the comparison value for the condition the parameter must meet for recording to start.

The "use mask" checkbox allows you to indicate whether the value that is read out is masked before it is compared to the value specified for the condition.

The Mask function allows you to 'hide' individual bits of an actual value before it is compared to the comparison "Value". The mask is entered in hexadecimal notation. Each digit of the hex value describes 4 bits so that the 8 hex values represent all of 32 possible bits of a value. The actual value of the monitored parameter is added to the mask (binary addition). If the result matches the specified comparison value, recording is started.

For example, if the value 0x00000005 is set, this means that only bit 0 and bit 3 are used for comparison to the comparison "Value".

The delay for starting recording after the condition has been satisfied is defined in the "Delay" field.
**Tab “Tuning”**  
Movements, for example a positive step, can be triggered on the “Tuning” tab. They can be evaluated for graphic optimization.

Tuning can only be started if the "Enable" switch is set to "On".

![Figure 5.21 Tab Tuning](image)

- **Reference**
  - **Amplitude**: Used to set the maximum amplitude of the reference value.
  - **Period**: Set in the “Period” field.
  - **Signal type**: Set in the “Signal type” dropdown list.
  - **Type**: Set in the “Type” dropdown list.
  - **Count**: Specifies the number of periods.

**Starting recording**
Use the “Start recording” button to start recording.

The recorded data is sent to the PC. The data is then visualized.
5.5.4 Inputs and outputs

⚠️ WARNING

UNEXPECTED MOVEMENT
Changing the settings may cause unexpected motor movements.
- Only changes settings if operation of the motor cannot result in hazards.

Failure to follow these instructions can result in death, serious injury or equipment damage.

The screenshots below may be different or unavailable in your system due to different functionalities of the devices.

The function "Inputs+Outputs" is used to monitor and display the analog and digital inputs as well as the digital outputs.

Use the menu item "⇒ Functions ⇒ Inputs+Outputs..." to start the function "Inputs+Outputs".

Forcing
The "Forcing" function offers the option of setting specific digital inputs, specific digital outputs and the voltage at the analog inputs directly. The currently available signal is disabled during this process. For example, this option can be used to apply the specified voltage via the analog input in "Oscillator" mode.
5.6 Diagnostics

The software provides a range of diagnostics and information functions for error detection and troubleshooting in various windows.

5.6.1 Device information

Use the menu item "⇒ Diagnostics ⇒ Device infos..." to display information on the device.

![Device info](image)

Figure 5.23 Device info

The device information window provides important information such as device type or serial number for diagnostics and service purposes.
5.6.2  Error memory

Use the menu item "⇒ Diagnostics ⇒ Error memory..." to display the error memory.

![Error memory window](image)

**Current error**
The current error, e.g. limit switch (LIMP/LIMN/REF), is output in the left section.

**Last error**
The current value of the operating hours meter and the error messages are displayed in the right part of the window.

The "Fault history" table shows the error messages in chronological order. The "Device status" column consists of: (error time)-(detailed error number)-(error class)

The "Additional information" table provides additional information on the error for every error message.

**Erase error memory**
Use the menu item "⇒ Diagnostics ⇒ Delete error memory..." and the button "Delete error memory" to delete the "error history" list.
5.6.3 Monitoring parameters

Use the menu item "⇒ Diagnostics ⇒ Object monitoring..." to monitor selected parameters of the device.

The parameter to be monitored is selected from the list. Click the "Monitor" button to display the parameter data in the table. You can add several parameters to the table for monitoring.

A value can be written directly to a parameter with the "Write" button.
6 Lexium CT M2

Depending on the product, the "Lexium CT ProductExplorer" starts the "Lexium CT M2" software.

6.1 The user interface

The following screenshot shows the user interface of the commissioning software.

Figure 6.1 User interface Lexium CT M2

(1) Menu bar
(2) Toolbar
(3) Control bar and status bar

The functions of the commissioning software can be accessed via the menu bar, the toolbar, the control bar and the status bar.
6.1.1 The menu bar

The menu bar adapts to the task at hand. It only contains the functions required for and possible in the current situation.

For example, if there is no connection to the device, the function "⇒ Connection ⇒ Disconnect" is not available.

6.1.2 The toolbar

The toolbar provides fast, single-click access to frequently used functions.

The buttons let you execute the following functions:

1. ⇒ File ⇒ Open...
2. ⇒ File ⇒ Save
3. ⇒ Connection ⇒ RS485 connection...
4. ⇒ Connection ⇒ CAN connection...
5. ⇒ Connection ⇒ Disconnect
6. ⇒ Parameter ⇒ Open parameter window...
7. ⇒ Functions ⇒ Operating modes...
8. ⇒ Functions ⇒ Recoding/Tuning...
9. ⇒ Functions ⇒ Inputs+Outputs...
10. ⇒ Diagnostics ⇒ Device info...
11. ⇒ Diagnostics ⇒ Error memory...
12. ⇒ Diagnostics ⇒ Object monitoring...

If you move the mouse pointer over a button, the software displays a "Tooltip"; in addition, a short description of the function may be shown in the "status bar".
6.1.3 Control bar and status bar

The control bar and the status bar allow you to access the device. The control bar and the status bar can be used to enable the power stage and display various status information.

![Control bar and status bar diagram]

(1) Access control
(2) Operating state
(3) Enable
(4) Stop
(5) Reset
(6) Current error
(7) Communication error
(8) Status information

**Access control**
The commissioning software receives access control via the "Access" button. For more information on access control, see the product manual of the device.

**Operating state**
The commissioning software shows the current operating state of the connected device. For more information on the operating state see the product manual of the device.

**Enable**
The switch "Enable" allows you to enable and disable the power stage of the device. For more information on enabling or disabling the power stage see the product manual of the device.

**Stop**
The "Stop" button allows you to stop the motor with a "Quick Stop". For more information on "Quick Stop" see the product manual of the device.

**Reset**
The "Reset" button is used to acknowledge an error message. For more information on acknowledging error messages see the product manual of the device.

**Current error**
The field shows the currently active asynchronous error.

**Communication error**
The field shows the communication errors (synchronous errors) in chronological order.

**Status information**
This information consists of:
- Line 1 shows whether the function "Halt" is active
- Line 2 displays the current motor position
- Line 3 shows the status of the access control
- Line 4 shows the control mode
6.2 First steps

6.2.1 Important terms

Device data

The term device data refers to all parameter values of a device. They are saved to the EEPROM of the device to avoid loss in case of a power outage.

Transferring device data

Device data can be transferred between the device and the PC only if there is a connection. It is possible to transfer all parameters or groups of parameters.

NOTE: In a first step, the commissioning software transfers modified parameters to the RAM memory of the device. They remain there until the controller supply voltage is switched off. Note that the device data must be saved separately to the EEPROM memory so they are permanently available to the product.

Parameter file

The device data can be saved to the PC and loaded.

On the PC, all device data is saved in one file, the parameter file. The commissioning software saves the complete parameter set in the file.

The PC and the device do not have to be connected if you want to edit the parameter file.
6.2.2 The first connection

The device must be connected to the PC via the data interface.

Use the menu item "⇒ Connection ⇒ RS485 connection...." to connect to the device. This opens the "Connection" dialog box.

The screenshot below shows an example.

Figure 6.4 Selection of the connection data with RS485

Settings

The "Modbus Point-to-Point" protocol must be used when the device is directly connected to the PC.

The "Modbus Multidrop" protocol must be used if the device is in a network in which multiple devices are connected together. The corresponding Modbus address must be set.

The setting of the Modbus address and the rate of transmission are described in the product manual of the device.

In devices with DeviceNet support CAN may be selected for the connection instead of RS485. If the connection over CAN is selected, the following window opens:

Figure 6.5 Selection of the connection data with CAN

If you check the "don't show again" checkbox, this dialog box is not displayed the next time the CAN connection is selected. In such a case, the connection is immediately established with the specified settings.
**Connection**  The device data is transferred to the PC when a connection is established. After transfer the commissioning software is connected to the device in online mode.

**Start-up message**  The commissioning software shows a start-up message depending on the device. For example, in the case of new devices or device that must be reset to the factory setting the commissioning software shows the following information.

![Start-up message](image)

**Figure 6.6**  Start-up message

*Please use the parameter group 'Simply start' for the first settings.*
6.3 Parameter file

Parameter files have the extension "*.ifx". Even if there is no connection to the device, you can open and edit any device file on the PC. In addition to the parameter values, the file contains the contents of the error memory, all actual values and recorded data.

6.3.1 Saving a file

On the PC, device data on the PC can be saved to a parameter file, for example, to archive it for maintenance and service purposes. This also allows you to quickly commission additional devices of the same device version.

To save a parameter file on the PC, use the menu items "⇒ File ⇒ Save..." or "⇒ File ⇒ Save as...."

It is recommended to save all device data in the form of a parameter file after you have commissioned a device. This way the device can be put back into operation immediately after a repair.

6.3.2 Opening a file

Use the menu item "⇒ File ⇒ Open..." to open a parameter file on the PC.

If there is a connection to the device, the commissioning software checks whether the parameter file is compatible with the device.

If the parameter file is compatible with the device, the stored parameter values of the parameter file are compared to the parameter values of the device. Differences are highlighted by a colored background.

If the parameter file is not compatible with the device, the loading process is canceled and an error message is displayed.
6.3.3 Exporting parameters

All device parameters that can be written can be saved as a .csv file for further processing. This function can be accessed via the menu item "⇒ File ⇒ Export parameters...".

The file is saved with the extension ".csv". You can open and edit this file Microsoft Excel.

6.3.4 Printing parameters

The menu item "⇒ File ⇒ Print parameters..." allows you to print the device data. The printed data is arranged in groups:

- Simply Start
- Configuration
- Settings
- Motion
- Communication
- Data sheet

In addition, the device type, serial number and information on the software are printed.
6.4 Parameterization

The data of a device can be edited in the "Parameter" window. A connection to the device is not required. The parameter values of a file can be modified in off-line mode and transferred to the device at a later point in time.

6.4.1 Opening the parameter window

Use the menu item "⇒ Parameter ⇒ Open parameter window..." to open the Parameter window.

![Parameter window](image)

The screenshot shows the parameter window. The contents of this window depend on the device version. However, the general structure is always the same. The left pane shows items, the associated parameters are displayed in the right pane.

**Parameters of a group**

The parameter window shows the parameters associated with the selected item. The list shows the names, values, unit, a description, the range and the Modbus address.

**Changing parameter values**

The value of a parameter is changed in the "Value" column. Values with a gray background are read-only and cannot be modified.

Modified values that have not been transferred to the device are highlighted by a colored background. At the same time the parameter group to which the parameter belongs is highlighted by a red exclamation mark. As soon as the values have been transmitted to the device, the exclamation mark is cleared.

To change a parameter value, you can enter the new value directly or choose it from a list.

**Checking the value range**

The commissioning software checks whether the parameter values entered are in the permissible value range. If the value entered is not in the valid range, the value is not accepted.
6.4.2 Transferring parameter values

When the controller supply voltage to the device is switched on, the device data is automatically copied from the EEPROM to the RAM. The devices only operate with the data contained in the RAM.

The data exchange between the device and the PC is controlled by the following menu items and buttons.

Menu items

The menu items "⇒ Parameter ⇒ Send parameter group to drive" and "⇒ Parameter ⇒ Send all parameters to drive" allow you to transmit parameter values from the PC to the device.

The menu items "⇒ Parameter ⇒ Load parameter group from drive" and "⇒ Parameter ⇒ Load all parameters from drive" are used to transmit parameter values from the device to the PC.

Buttons

The buttons let you execute the following functions:

Figure 6.8 Buttons for data transmission

(1)  ⇒ Parameter ⇒ Send parameter group to drive
(2)  ⇒ Parameter ⇒ Load parameter group from drive
(3)  ⇒ Parameter ⇒ Send all parameters to drive
(4)  ⇒ Parameter ⇒ Load all parameters from drive
(5)  ⇒ Parameter ⇒ Save device parameters in EEPROM

Not all parameters can be transferred in operating state "Operation Enable". Parameter values that cannot be transferred are highlighted by a colored background.
6.4.3 Restoring the factory settings

Use the menu item "⇒ Parameter ⇒ Reset to factory settings" to restore the factory settings of all parameters.

![Image of warning dialog]

Figure 6.9 Restoring the factory settings

After confirmation with "OK" all device parameters are reset to the factory setting.

6.4.4 Resetting user parameters

All user parameters can be reset to the factory setting with the menu item " ⇒ Parameter ⇒ Reset user parameters". The user parameters include all parameters except for (if present):

- Communication parameter
- Definition of the direction of rotation
- Signal selection at position interface
- device controller
- Logic type
- Start-up operating mode for "Local Control Mode"
- ESIM settings
- Motor type
- Processing the motor encoder position
- IO function

![Image of warning dialog]

Figure 6.10 Reset user parameters

After validation with "OK" all user parameters are reset. The user parameters are not backed up to the EEPROM!
6.4.5 Calculating control loop parameters

Use the menu item "⇒ Parameter ⇒ Calculate controller parameter" to reset the control loop parameters to the factory settings.

![Figure 6.11 Resetting the control loop parameters](image)

When you confirm with "OK", control loop parameters for the speed controller and the position controller are reset.
6.5 Functions

The “Functions” menu let you access the following functions:

- Operating modes
- Recording and tuning
- Inputs and outputs

*The screenshots below may be different or unavailable in your system due to different functionalities of the devices.*

6.5.1 Changing the operating state

An exclusive access is required for controlling the device with the commissioning software. Use the "Access" switch on the control and status bar to access the device. When the device is accessed, the software displays a safety instruction which must be confirmed with a key combination. For more information on access control, see the product manual of the device.

⚠️ WARNING

**UNEXPECTED MOVEMENT**

When the drive is operated for the first time, there is a risk of unexpected movements caused by possible wiring errors or unsuitable parameters.

- Perform the first test run without coupled loads.
- Verify that a functioning button for EMERGENCY STOP is within reach.
- Anticipate movements in the incorrect direction or oscillation of the drive.
- Only start the system if there are no persons or obstructions in the hazardous area.

**Failure to follow these instructions can result in death, serious injury or equipment damage.**

The device can now be set to operating state 6 "Operation Enable" with the commissioning software. In this operating state the power stage of the device is enabled. To do so, click the "Enable" switch. For more information on enabling or disabling the power stage see the product manual of the device.

The device must be in operating state 6 "Operation Enable" for the functions of the commissioning software to be executed.
6.5.2 Operating modes

Use the menu item "⇒ Functions ⇒ Operating modes..." to start the "Operating modes" function.

The various operating modes can be selected from the tabs in the Operating Modes window.

The window is subdivided into two sections:

- Tab for the selected operating mode and for setting specific parameters (top section)
- Display of some status information (bottom section)

The user can switch between the tabs in the Operating Modes window without interfering with a currently active operating mode.

**Device monitoring**

During movements, the connection to the device is cyclically monitored. If the connection between the PC and device is lost, the motor stops within the cycle time.

The commissioning software cannot be exited while a movement is running.

All operating modes are described in detail in the product manuals. Therefore, this manual does not describe the details of the operating modes.

**Profile position**

In Profile Position operating mode, a movement with an adjustable motion profile is performed from a start position to a target position. The value of the target position can be specified as either a relative or an absolute position.

You can set a motion profile with values for acceleration ramp, deceleration ramp and target speed.

Figure 6.12 Operating mode Profile Position
**Profile Velocity**

In the operating mode Profile Velocity, the drive accelerates to an adjustable target speed of rotation. You can set a motion profile with values for acceleration and deceleration ramps.

![Figure 6.13 Operating mode Profile velocity](image)

**Homing**

The operating mode Homing establishes an absolute position reference between the motor position and a defined axis position. Homing can be carried out by a means of a reference movement or by position setting.

![Figure 6.14 Homing tab](image)

**Jog**

The motor is moved at slow or fast jog speed with the buttons. The motor moves as long as the button is held down. When you release the button, the motor is decelerated to a standstill.

![Figure 6.15 Operating mode Jog](image)
**Electronic gear**

In the operating mode Electronic Gear, reference signals are supplied in the form of A/B signals or pulse/direction signals. A new position reference value is calculated on the basis of these signals plus an adjustable gear ratio.

![Operating mode Electronic Gear](image)

**Oscillator**

**WARNING**

**UNEXPECTED MOVEMENT**

In this operating mode, an unknown voltage value at the analog input may cause an unexpectedly high speed of rotation of the motor.

- Observe the voltage value at the analog input when starting the operating mode.

Failure to follow these instructions can result in death, serious injury or equipment damage.

In the Oscillator operating mode, the motor is moved corresponding to a voltage-dependent reference speed. There are two options:

- Selection of speed of rotation directly in the window by entering the value or using the slider.

- Supply of the value via the analog input ANA1. The voltage value can also be set in the "Inputs+Outputs" window for this option.

The actual movement is started or stopped with the "Start" and "Stop" buttons.

![Operating mode Oscillator](image)
Speed control

⚠️ WARNING

UNEXPECTED MOVEMENT
In this operating mode, an unknown voltage value at the analog input may cause an unexpectedly high speed of rotation of the motor.

- Observe the voltage value at the analog input when starting the operating mode.

Failure to follow these instructions can result in death, serious injury or equipment damage.

In the Speed Control operating mode, the motor is moved corresponding to a voltage-dependent reference speed. There are two options:

- Selection of the value directly in the window by entering the value or using the slider
- Supply of the value via the analog input ANA1. The voltage value can also be set in the "Inputs+Outputs" window for this option.

The actual movement is started or stopped with the "Start" and "Stop" buttons.

Figure 6.18 Operating mode Speed Control
Current control

⚠️ WARNING

UNEXPECTED MOVEMENT

In this operating mode, an unknown voltage value at the analog input may cause an unexpectedly high speed of rotation of the motor.

- Observe the voltage value at the analog input when starting the operating mode.

Failure to follow these instructions can result in death, serious injury or equipment damage.

In the Current Control operating mode, the motor is moved corresponding to a voltage-dependent reference current. There are two options:

- Selection of current directly in the window by entering the value or using the slider
- Supply of the value via the analog input ANA1. The voltage value can also be set in the "Inputs+Outputs" window for this option.

The actual movement is started or stopped with the "Start" and "Stop" buttons.

![Operating modes](image)

Figure 6.19 Operating mode Current Control
Autotuning

⚠️ WARNING

UNEXPECTED MOVEMENT

Autotuning moves the motor in order to tune the controller. Incorrect parameters may cause unexpected movements or the loss of monitoring functions.

- Check the parameters $AT_{dir}$ and $AT_{dis}$. The distance required for the deceleration ramp must also be taken into account.
- Verify that the parameter $LIM_{I_{max}QSTP}$ for QuickStop is correctly set.
- If possible, use the limit switches $LIMN$ and $LIMP$.
- Verify that a functioning button for EMERGENCY STOP is within reach.
- Make sure that the system is free and ready for the motion before starting the function.

Failure to follow these instructions can result in death, serious injury or equipment damage.

Autotuning determines the friction torque, a constantly effective load torque, and considers this in the calculation of the mass moment of inertia of the entire system.

![Operating modes](image)

Figure 6.20 Autotuning
6.5.3 Recording and optimizing

Introduction The commissioning software provides the "Recording/Tuning" function for visualizing internal device data during movements. The connected device stores the movement data to an internal memory for a defined recording period and then sends it to the PC. The PC processes the data and displays them in the form of charts or tables.

Recorded data can be saved on the PC, see chapter 6.3.1 "Saving a file", and can be archived or printed for documentation purposes.

Use the menu item ⇒ Functions ⇒ Record/Tuning... to start the "Record" function.

Figure 6.21 Recording

Elements of the recording window:

1. Buttons
2. Chart with the recorded data
3. Tabs for recording, trigger and tuning

Chart A chart is only shown if at least one parameter was selected.

Each of the selected parameters is shown in a distinct color.
Buttons

![Buttons](image)

Figure 6.22 Buttons

1. Starting recording
2. Stop recording
3. Zoom in, y axis
4. Zoom out, y axis
5. Infinitely variable zoom, x axis and y axis
6. Zoom selected rectangle
7. 1st display of values for a specific time
8. Change displayed values for first display
   (x and y value, x value, y value, period, peak/peak value)
9. 2nd display of values for a specific time
10. Change displayed values for second display
    (x and y value, x value, y value, period, peak/peak value)
11. Restore original display
12. Invert y axis
13. Display table of recorded values
14. Enter description
15. Show/hide configuration
16. Print recording

"Recording" tab

The desired recording is configured in the "Recording" tab.

![Recording tab](image)

Figure 6.23 Recording tab

The desired parameters are selected in the "Available parameters" input field. A maximum of 4 parameters can be selected. If a parameter is no longer required, it can be deselected by a double-click on the name of the parameter.

The desired recording increment is select in the "Time base" input field. The smaller the "Time base" the smaller the maximum recording time.
"Trigger" tab  The desired triggering for the recording is configured in the "Trigger" tab. The recording starts once the specified event has occurred.

The parameters for monitoring are selected in the "Trigger" input field.

The event that the selected parameter must meet to start the recording is selected in the "Event" input field.

The decimal whose comparison value the parameter must meet to start the recording is selected in the "Comparison value" input field.

If "Binary AND" or "Binary OR" is selected as the event, the "Mask" input field is opened.

The Mask function offers the option of hiding individual bits of an actual value before it is compared with the "Comparison value". The mask is input in the hexadecimal system. Every position of the hex value describes 4 bits that through the 8 hex values shows all of the maximum 32 possible bits of a value. The actual value of the monitored parameter added to the mask in binary form. If the revenue matches the specified comparison value, the recording is deleted.

For example, if the value 00000005 is set, this means that only bit 0 and bit 3 are used for comparison with the "comparison value".

The delay with which the recording is to be started after the condition has been met is set in the "time" input field. If a value with a minus sign is input, the recording is started before the selected event occurs.
Tab "Tuning" Movements, for example a positive step, can be triggered on the "Tuning" tab. They can be evaluated for graphic optimization.

Tuning can only be started if the "Access" and "Enable" switches are set to "On".

The "Amplitude" field is used to set the maximum amplitude of the reference value.

The offset of the amplitude in positive or negative direction can be set in the "Offset" field.

The duration of a period is set in the "Period" field.

The signal type for the reference value is set in the "Signal type" dropdown list.

The controller to be used is set in the "Type" dropdown list.

The number of periods is specified in the "Count" field.

The maximum number of revolutions that can be triggered by tuning can be set in the "Range" field. This value can, for example, help to avoid a movement to block.

The "auto-start" radio buttons allow you to link the execution of the tuning movement and the start of recording. If the option is set to "Off", the software displays a Start button. The Start button lets you trigger the tuning movement separately from starting the recording. Settings that you may have made on the "Trigger" tab are lost if you set "auto-start" to "On".

Starting recording Use the "Start recording" button to start recording.

The recorded data is sent to the PC. The data is then visualized.
6.5.4 Inputs and outputs

⚠️ WARNING

UNEXPECTED MOVEMENT
Changing the settings may cause unexpected motor movements.
- Only changes settings if operation of the motor cannot result in hazards.
Failure to follow these instructions can result in death, serious injury or equipment damage.

The screenshots below may be different or unavailable in your system due to different functionalities of the devices.

The function "Inputs+Outputs" is used to monitor and display the analog and digital inputs as well as the digital outputs.

Use the menu item "⇒ Functions ⇒ Inputs+Outputs..." to start the function "Inputs+Outputs".

![Inputs+Outputs](image)

Figure 6.26 Inputs and outputs

**Forcing**
The "Forcing" function offers the option of setting specific digital inputs, specific digital outputs and the voltage at the analog inputs directly. The currently available signal is disabled during this process. For example, this option can be used to apply the specified voltage via the analog input in "Oscillator" mode.
6.6 Diagnostics

The software provides a range of diagnostics and information functions for error detection and troubleshooting in various windows.

6.6.1 Device information

Use the menu item "⇒ Diagnostics ⇒ Device infos..." to display information on the device.

Figure 6.27 Device info

The device information window provides important information such as device type or serial number for diagnostics and service purposes.
6.6.2 Error memory

Use the menu item "⇒ Diagnostics ⇒ Error memory..." to display the error memory.

![Image of error memory]

**Current error**
The current error, e.g. limit switch (LIMP/LIMN/REF), is output in the left section.

**Last error**
The current value of the operating hours meter and the error messages are displayed in the right part of the window.

The "Fault history" table shows the error messages in chronological order. The "Device status" column consists of: (error time)-(detailed error number)-(error class)

The "Additional information" table provides additional information on the error for every error message.

**Erase error memory**
Use the menu item "⇒ Diagnostics ⇒ Delete error memory..." and the button "Delete error memory" to delete the "error history" list.
6.6.3 Monitoring parameters

Use the menu item "⇒ Diagnostics ⇒ Object monitoring..." to monitor selected parameters of the device.

![Monitoring parameters](image)

Figure 6.29 Monitoring parameters

The parameter to be monitored is selected from the list. Click the "Monitor" button to display the parameter data in the table. You can add several parameters to the table for monitoring.

A parameter can also be monitored if you enter the Modbus address. The current value is displayed directly in the Value field.
7 Diagnostics and troubleshooting

7.1 Error indication

Overview
The commissioning software provides a range of diagnostics and information functions for error detection and troubleshooting in various windows and panes:

- Diagnostics functions for the device
  ⇒ Diagnostics ⇒ Device info (see 5.6.1 "Device information" and 6.6.1 "Device information")
- Error information on the device
  ⇒ Diagnostics ⇒ Error memory (see 5.6.2 "Error memory" and 6.6.2 "Error memory")
- Monitoring parameters
  ⇒ Diagnostics ⇒ Object monitoring (see 5.6.3 "Monitoring parameters" and 6.6.3 "Monitoring parameters")
- Error information on the control bar which is permanently displayed in the active window.

Error indication
The cause of an error is displayed:

- At the device by means of the device-specific equipment, e.g. LED or segment displays
- By the error response of the device
- In the commissioning software as an error message in the control bar and as the last error message in the error memory

Error information is displayed on the toolbar along with the specific error message; the gray field below that contains additional information.

Resetting error messages
The additional information can be deleted by a double-click, but remain available in the error history.

The error state can be reset with the "Reset" button after the cause of the error has been corrected.
# 8 Glossary

## 8.1 Units and conversion tables

The value in the specified unit (left column) is calculated for the desired unit (top row) with the formula (in the field).

Example: conversion of 5 meters [m] to yards [yd]

\[
5\text{ m} / 0.9144 = 5.468\text{ yd}
\]

### 8.1.1 Length

<table>
<thead>
<tr>
<th>in</th>
<th>ft</th>
<th>yd</th>
<th>m</th>
<th>cm</th>
<th>mm</th>
</tr>
</thead>
<tbody>
<tr>
<td>in</td>
<td>-</td>
<td>/12</td>
<td>/36</td>
<td>* 0.0254</td>
<td>* 2.54</td>
</tr>
<tr>
<td>ft</td>
<td>* 12</td>
<td>-</td>
<td>/3</td>
<td>* 0.30479</td>
<td>* 30.479</td>
</tr>
<tr>
<td>yd</td>
<td>* 36</td>
<td>* 3</td>
<td>-</td>
<td>* 0.9144</td>
<td>* 91.44</td>
</tr>
<tr>
<td>m</td>
<td>/ 0.0254</td>
<td>/ 0.30479</td>
<td>/ 0.9144</td>
<td>-</td>
<td>* 100</td>
</tr>
<tr>
<td>cm</td>
<td>/ 2.54</td>
<td>/ 30.479</td>
<td>/ 91.44</td>
<td>/ 100</td>
<td>-</td>
</tr>
<tr>
<td>mm</td>
<td>/ 25.4</td>
<td>/ 304.79</td>
<td>/ 914.4</td>
<td>/ 1000</td>
<td>/ 10</td>
</tr>
</tbody>
</table>

### 8.1.2 Mass

<table>
<thead>
<tr>
<th>lb</th>
<th>oz</th>
<th>slug</th>
<th>kg</th>
<th>g</th>
</tr>
</thead>
<tbody>
<tr>
<td>lb</td>
<td>-</td>
<td>* 16</td>
<td>* 0.03108095</td>
<td>* 0.4535924</td>
</tr>
<tr>
<td>oz</td>
<td>/16</td>
<td>-</td>
<td>* 1.942559*10^{-3}</td>
<td>* 0.02834952</td>
</tr>
<tr>
<td>slug</td>
<td>/ 0.03108095</td>
<td>/ 1.942559*10^{-3}</td>
<td>-</td>
<td>* 14.5939</td>
</tr>
<tr>
<td>kg</td>
<td>/ 0.453592370</td>
<td>/ 0.02834952</td>
<td>/ 14.5939</td>
<td>-</td>
</tr>
<tr>
<td>g</td>
<td>/ 453.592370</td>
<td>/ 28.34952</td>
<td>/ 14593.9</td>
<td>/ 1000</td>
</tr>
</tbody>
</table>

### 8.1.3 Force

<table>
<thead>
<tr>
<th>lb</th>
<th>oz</th>
<th>p</th>
<th>dyne</th>
<th>N</th>
</tr>
</thead>
<tbody>
<tr>
<td>lb</td>
<td>-</td>
<td>* 16</td>
<td>* 453.55358</td>
<td>* 444822.2</td>
</tr>
<tr>
<td>oz</td>
<td>/16</td>
<td>-</td>
<td>* 28.349524</td>
<td>* 27801</td>
</tr>
<tr>
<td>p</td>
<td>/ 453.55358</td>
<td>/ 28.349524</td>
<td>-</td>
<td>* 980.7</td>
</tr>
<tr>
<td>dyne</td>
<td>/ 444822.2</td>
<td>/ 27801</td>
<td>/ 980.7</td>
<td>-</td>
</tr>
<tr>
<td>N</td>
<td>/ 4.448222</td>
<td>/ 0.27801</td>
<td>/ 9.807*10^{-3}</td>
<td>* 100*10^{3}</td>
</tr>
</tbody>
</table>

### 8.1.4 Power

<table>
<thead>
<tr>
<th>HP</th>
<th>W</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP</td>
<td>-</td>
</tr>
<tr>
<td>W</td>
<td>/ 745.72218</td>
</tr>
</tbody>
</table>
## 8 Glossary

### 8.1.5 Rotation

<table>
<thead>
<tr>
<th>Unit</th>
<th>Formula</th>
<th>Conversion Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>min⁻¹ (RPM)</td>
<td>* π / 30</td>
<td>57.295</td>
</tr>
<tr>
<td>rad/s</td>
<td>* 30 / π</td>
<td></td>
</tr>
<tr>
<td>deg/s</td>
<td>/ 6</td>
<td>/ 57.295</td>
</tr>
</tbody>
</table>

### 8.1.6 Torque

<table>
<thead>
<tr>
<th>Unit</th>
<th>Formula</th>
<th>Conversion Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>lb-in</td>
<td>- / 12</td>
<td>* 0.112985</td>
</tr>
<tr>
<td>lb-ft</td>
<td>* 12 / 12</td>
<td>* 0.135822</td>
</tr>
<tr>
<td>oz-in</td>
<td>* 192 / 12</td>
<td>* 1.35822</td>
</tr>
<tr>
<td>Nm</td>
<td>/ 0.112985</td>
<td>/ 7.0616*10⁻³</td>
</tr>
<tr>
<td>kp-m</td>
<td>/ 0.011521</td>
<td>* 0.101972</td>
</tr>
<tr>
<td>kp-cm</td>
<td>/ 1.1521</td>
<td>/ 10.1972</td>
</tr>
<tr>
<td>dyne-cm</td>
<td>/ 1.129*10⁶</td>
<td>/ 7.0615.5</td>
</tr>
</tbody>
</table>

### 8.1.7 Moment of Inertia

<table>
<thead>
<tr>
<th>Unit</th>
<th>Formula</th>
<th>Conversion Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>lb-in²</td>
<td>- / 144</td>
<td>/ 3417.16</td>
</tr>
<tr>
<td>lb-ft²</td>
<td>* 144 / 144</td>
<td>* 0.4214</td>
</tr>
<tr>
<td>kg-m²</td>
<td>* 3417.16 / 0.4214</td>
<td>/ 10*10³</td>
</tr>
<tr>
<td>kg-cm²</td>
<td>* 0.341716 / 421.4</td>
<td>-</td>
</tr>
<tr>
<td>kp-cm-s²</td>
<td>* 335.109 / 0.429711</td>
<td>/ 980.665</td>
</tr>
<tr>
<td>oz-in²</td>
<td>/ 16 / 2304</td>
<td>/ 54674</td>
</tr>
</tbody>
</table>

### 8.1.8 Temperature

<table>
<thead>
<tr>
<th>Unit</th>
<th>Formula</th>
<th>Conversion Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>°F</td>
<td>(°F - 32) * 5/9</td>
<td>(°F - 32) * 5/9 + 273.15</td>
</tr>
<tr>
<td>°C</td>
<td>°C * 9/5 + 32</td>
<td>°C + 273.15</td>
</tr>
<tr>
<td>K</td>
<td>(K - 273.15) * 9/5 + 32</td>
<td>K - 273.15</td>
</tr>
</tbody>
</table>

### 8.1.9 Conductor Cross Section

<table>
<thead>
<tr>
<th>AWG</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
<th>13</th>
</tr>
</thead>
<tbody>
<tr>
<td>mm²</td>
<td>42.4</td>
<td>33.6</td>
<td>26.7</td>
<td>21.2</td>
<td>16.8</td>
<td>13.3</td>
<td>10.5</td>
<td>8.4</td>
<td>6.6</td>
<td>5.3</td>
<td>4.2</td>
<td>3.3</td>
<td>2.6</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>AWG</th>
<th>14</th>
<th>15</th>
<th>16</th>
<th>17</th>
<th>18</th>
<th>19</th>
<th>20</th>
<th>21</th>
<th>22</th>
<th>23</th>
<th>24</th>
<th>25</th>
<th>26</th>
</tr>
</thead>
<tbody>
<tr>
<td>mm²</td>
<td>2.1</td>
<td>1.7</td>
<td>1.3</td>
<td>1.0</td>
<td>0.82</td>
<td>0.65</td>
<td>0.52</td>
<td>0.41</td>
<td>0.33</td>
<td>0.26</td>
<td>0.20</td>
<td>0.16</td>
<td>0.13</td>
</tr>
</tbody>
</table>
8.2 Terms and Abbreviations

**Asynchronous error**  Error which is detected and signaled by the internal monitoring unit of the controller.

**Default value**  Factory setting.

**DOM**  The Date of manufacturing on the nameplate of the device is shown in the format DD.MM.YY, e.g. 31.12.06 (December 31, 2006).

**Direction of rotation**  Rotation of the motor shaft in a clockwise or counterclockwise direction of rotation. Clockwise rotation is when the motor shaft rotates clockwise as you look at the end of the protruding motor shaft.

**Limit switch**  Switch that signals overtravel of the permissible range of travel.

**Power stage**  The power stage controls the motor. The power stage generates currents for controlling the motor on the basis of the positioning signals from the controller.

**Fatal error**  In the case of fatal error, the drive is not longer able to control the motor, so that an immediate switch-off of the drive is necessary.

**Fault**  Operating state of the drive caused as a result of a discrepancy between a detected (computed, measured or signaled) value or condition and the specified or theoretically correct value or condition.

**Fault reset**  A function used to restore the drive to an operational state after a detected fault is cleared by removing the cause of the fault so that the fault is no longer active (transition from state "Fault" to state "Operation Enable").

**Error class**  Classification of errors into groups. The different error classes allow for specific responses to faults, e.g. by severity.

**LED**  Light Emitting Diode

**Node guarding**  Monitoring of the connection with the slave at an interface for cyclic data traffic.

**Parameter**  Device data and values that can be set by the user.

**RS485**  Fieldbus interface as per EIA-485 which enables serial data transmission with multiple devices.

**Synchronous error**  Error signaled by the controller if it is unable to execute a command received from the master.

**Warning**  If not used within the context of safety instructions, a warning alerts to a potential problem detected by a monitoring function. A warning is not a fault and does not cause a transition of the operating state. Warnings belong to error class 0.
9 Index

Symbols
"Recording" tab 73
"Trigger" tab 74

A
Abbreviations 85
Access control 55
Accessories 15

B
Before you begin
   Safety information 11
Buttons 35, 62

C
Changing the operating state 37, 65
Commissioning software 15
Communication error 55
Control bar and status bar 29, 55
Current error 29, 50, 55, 78

D
Data interface 22
Device data 29, 56
Device information 49, 77
Device monitoring 38, 66
Diagnostics 49, 77, 81

E
Electronic gear 39, 68
Enable 29, 55
Erase error memory 50, 78
Error indication 81
Error memory 50, 78
Establishing a connection 31, 57
Exporting parameters 33, 60

F
First steps 22, 29, 56
Forcing 48, 76
Functions 37, 65
Functions of the commissioning software 9

G
General features 9
Glossary 83

H
Hazard categories 12
Homing 39, 67

I
Important terms 22, 29, 56
Inputs and outputs 48, 76
Installation procedure 15
Intended use 11
Introduction 9

J
Jog 39, 67

L
Last error 50, 78

M
Menu bar 20, 28, 54
Menu items 35, 62
Monitoring parameters 51, 79

O
Opening a file 32, 59
Opening the parameter window 34, 61
Operating modes 37, 66
Operating state 29, 55
Oscillator 40, 68

P
Parameter file 30, 32, 56, 59
Parameterization 34, 61
Printing parameters 33, 60
Profile position 38, 66
Profile Velocity 38, 67

Q
Qualification of personnel 11

R
Recording and optimizing 44, 72
Required accessories 15
Reset 29, 55
Resetting error messages 81
Resetting user parameters 63
Restoring the factory settings 36, 63

S
Saving a file 32, 59
Source
  Commissioning software 15
Starting recording 47, 75
Start-up message 58
Status information 29, 55
Stop  29, 55
Supported devices  9
System requirements  15

T
Tab "Record"  45
Tab "Trigger"  46, 47, 75
Terms  85
Toolbar  28, 54
Transferring parameter values  35, 62
Tree View  20
Troubleshooting  81

U
Units and conversion tables  83
User interface  19, 27, 53